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This tutorial introduces you to geocoding with ESRI® ArcGIS� 8.1. It will
show you the basic techniques for creating geocoding services and
performing address geocoding with ArcGIS. Complete exercises 2 and 3 to
learn about some advanced features�using alternate names and place
name aliases and creating a dynamic feature class that is related to the
address table.

This tutorial assumes that you are already familiar with using ArcCatalog�
and ArcMap�. You should know how to copy data to a new location and
add data to a map. You should also have a basic understanding about what
a geodatabase is and the objects they can contain. If you�re new to GIS or
feel you need to refresh your knowledge, please take some time to read
Getting Started with ArcGIS. You might also work though the quick-start
tutorials in Using ArcCatalog and Using ArcMap.

Geocoding tutorial
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Exercise 1: Locating and rematching addresses

In the first part of this tutorial you�ll learn how to create a
new geocoding service, how to locate an address on a map,
and how to create a set of point features representing street
addresses stored in a table such as customer locations.

Before you begin, you must make a copy of the data used
in this tutorial so the original tutorial data will remain
unmodified. Copy the Atlanta folder to a new location on
your computer such as the C:\ disk; you�ll find it in the
ArcTutor\Geocoding folder on the local disk where the
tutorial data was installed�for example, at C:\ArcGIS.
You�ll need 5 MB of free disk space to store the Atlanta
folder.

The Atlanta folder contains a personal geodatabase named
Atlanta.

Creating a new geocoding service

A geocoding service lets you convert textual descriptions
of locations into geographic features. The Geocoding
Services folder at the top level of the Catalog tree lets you
manage existing and create new geocoding services on

your computer. The first thing you�ll do is create a
geocoding service based on your copy of the Atlanta
personal geodatabase.

1. Start ArcCatalog.

2. In the Geocoding Services folder at the top level in the
Catalog tree, double-click Create New Geocoding
Service.

The Create New Geocoding Service dialog box appears.

3. Click the geocoding style US Streets with Zone (GDB),
then click OK.
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The New US Streets with Zone (GDB) Geocoding
Service dialog box appears.

4. In the Name text box, replace the default name �New
Geocoding Service� with the name �Atlanta�.

5. In the Primary table tab, click the Browse button next to
the Reference data text box.

6. In the Choose Reference Data dialog box, navigate to
the folder containing your copy of the Atlanta personal
geodatabase. Double-click the personal geodatabase,
click the streets feature class, then click Add.

7. Click OK in the New US Streets with Zone (GDB)
Geocoding Service dialog box. The new geocoding
service appears in the Geocoding Services folder.

You�ll notice that the name of the geocoding service is
prefaced by your login name. If your login name is
�ssmith�, the geocoding service would appear in the
Catalog as �ssmith.Atlanta�. New geocoding services
are private; other users who log in to the same computer
won�t have access to your geocoding services.

When the new geocoding service is created, a
geocoding index is built for the streets feature class
within the Atlanta geodatabase. The index is stored in a
new table named GC_SZS1 in the Atlanta geodatabase.
With this index, the street features can be quickly
matched to the addresses you want to geocode.

You can modify a geocoding service�s properties after it
has been created.

8. Right-click the yourLogin.Atlanta geocoding service and
click Properties. The Geocoding Service Properties
dialog box appears.

9. On the right under Matching Options, you can see that
the default Minimum candidate score is 10. Change this
value to 30.

5



4 GEOCODING TUTORIAL

10. Click OK.

Your changes are saved in the geocoding service. Now you
can use this geocoding service to find out where addresses
are located on a map.

Finding an address interactively

You can use geocoding services to locate addresses while
your are working in ArcMap.

1. Start ArcMap and click OK to create a new, empty
map.

2. Add the streets feature class in the Atlanta geodatabase
to the map.

3. Click the Find button on the Tools toolbar.

4. In the Find dialog box, click the Addresses tab.

Before you can locate an address on your map, you
must identify the geocoding service you want to use.

5. Click the Browse button to choose a geocoding service.
Navigate to the Geocoding Services folder, click the
yourLogin.Atlanta geocoding service, and click Add.

6. Type �150 Linden Ave NE� in the Street or Intersection
text box. Type �30308� in the Zone text box.

7. Click Find.

One candidate address appears in the list at the bottom
of the Find dialog box.

8. Right-click the candidate and click Add as Graphic(s) to
Map.

Find
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A graphic point representing the address�s location
appears on the map.

9. Check Show all candidates in the Find dialog box and
click Find again.

This time you�ll see several candidates in the list. All
candidates whose score is above the minimum candidate
score as defined in the geocoding service will appear in
the list. When Show all candidates is not checked, only
candidates whose score is above the minimum match
score will be listed. For this geocoding service the
minimum candidate score is 30 and the minimum match
score is 60.

10. Click the Close button in the upper right corner of the
Find dialog box.

The list of candidates is generated by breaking the address
into its individual components, then comparing each

component to the reference data. The score indicates how
closely each candidate feature in the reference data
matches the address that you are geocoding. A score will
be lower if the street number doesn�t fall within the address
range for the candidate or if the street name is misspelled,
for example.

Geocoding addresses in a table

If you have a table that contains address information, you
can geocode all of its addresses at once. This can show you
where your customers are located.

1. Open a new map document in ArcMap. Don�t save the
map you created in the previous task.

2. Add the streets feature class and the customers table
from the Atlanta geodatabase to your map.

3. Click the Tools menu, point to Geocoding, then click
Geocode Addresses. Or right-click the customers table
in the Source tab of the map�s table of contents and
click Geocode Addresses.

4. Click Add.

5. In the Add Geocoding Service dialog box, navigate to
the Geocoding Services folder, click the
yourLogin.Atlanta geocoding service, then click Add.

6. Click yourLogin.Atlanta in the Choose a geocoding
service to use dialog box, then click OK.
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7. In the Geocode Addresses: yourLogin.Atlanta dialog
box, click the Browse button to define the Output
shapefile or feature class.

8. In the Saving Data dialog box, navigate to the Atlanta
personal geodatabase, then double-click the personal
geodatabase. Click the Save as type dropdown arrow,
then click Personal Geodatabase feature classes. In the
Name text box, type �atlanta_results�. Click Save.

A new point feature class named atlanta_results will be
created in the Atlanta geodatabase. The point features
generated by the geocoding process will be saved in that
feature class.

9. Click OK to start geocoding.

When the geocoding process is finished, the Review/
Rematch Addresses dialog box appears. It shows the
statistics of the addresses that were matched or not
matched. You�ll rematch the unmatched addresses later
in the tutorial.
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10. Click Done.

A Geocoding Result layer is added to the map. It shows the
points that were added to the atlanta_results feature class.

You can geocode a table of addresses in ArcCatalog as
well as ArcMap. To do so, you would right-click the
customers table in the Atlanta geodatabase and click
Geocode Addresses. In the Select Geocoding Service dialog
box, you would click yourLogin.Atlanta and click OK.
Then, you would follow steps 8 through 10 in the task above
to match the addresses. When you geocode a table of
addresses in ArcCatalog, the resulting feature class will not
be added to ArcMap automatically.

Rematch addresses

1. In ArcMap, click the Geocoding Result: atlanta_results
layer in the table of contents.

2. Click the Tools menu, point to Geocoding, point to
Review/Rematch Addresses, then click Geocoding
Result: atlanta_results. Or right-click the Geocoding
Result: atlanta_results layer, point to Data, then click
Review/Rematch Addresses.

3. The message �This operation requires that you be
editing this workspace. Would you like to start editing?�
appears. Click Yes.

The Review/Rematch Addresses dialog box appears.

4. In the Rematch Criteria, click Addresses with
candidates tied.

5. Click Match Interactively.
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The Interactive Review dialog box appears. The
address records that you have chosen to rematch are
listed at the top of the dialog box. In this exercise there
is one record in the feature class that has candidates
that are tied for the highest match score. The tied
candidates are listed at the bottom of the dialog box.

6. Arrange the ArcMap window and the Interactive
Review dialog box so you can see the map. The location
of the selected candidate is highlighted on the map.

7. Click the second candidate in the candidate list. The
location of the highlighted candidate changes on the
map.

8. In the bottom right-hand corner of the Interactive
Review dialog box, click Match. The selected address in
the list at the top of the dialog box is now associated
with the second candidate in the list at the bottom.

9. Click Close.

10. Click Done in the Review/Rematch Addresses dialog
box.

As with geocoding, you can also rematch addresses
with ArcCatalog. To do so, refresh the contents of the
Atlanta geodatabase if you don�t see the atlanta_results
feature class listed in the Contents tab. Right-click the
atlanta_results feature class, then click
Review/Rematch Addresses. Follow steps 4 through 8
above to rematch the addresses. When you rematch
addresses with ArcCatalog, the locations of the
candidates will not appear on a map.

11. On the Editor toolbar, click the Editor menu and click
Stop Editing. Click Yes to save your changes.
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A geocoding service has the option to use alternate names
and place name aliases. Place name aliases let you
associate names of well-known places with street
addresses�for example, the names of museums, hospitals,
or landmarks. When geocoding an address, the place name
alias table is consulted first. If found, the street address
from the place name alias table is geocoded instead.
Similarly, alternate names can be defined for features in the
reference data. When geocoding an address, the alternate
street name table is also searched to find potential
candidates.

Creating a geocoding service that uses alternate
names and place name aliases

In this task you�ll create a new geocoding service that uses
alternate names and place name aliases, then use that
service in ArcMap to find addresses.

1. In ArcCatalog, click the Geocoding Services folder at
the top level in the Catalog tree, then double-click
Create New Geocoding Service.

2. Click the geocoding style US Streets with AltName
(GDB), then click OK.

The New US Streets with AltName (GDB) Geocoding
Service dialog box appears.

3. In the Name text box, replace the default name �New
Geocoding Service� with the name �Atlanta_AltName�.

4. In the Primary table tab, click the Browse button next to
the Reference data text box.

5. In the Choose Reference Data dialog box, navigate to
the Atlanta personal geodatabase. Double-click the
personal geodatabase, click the streets feature class,
then click Add.

8

Exercise 2: Using alternate names and place name aliases
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6. In the New US Streets with AltName (GDB)
Geocoding Service dialog box, click the Alternate Name
table tab.

7. Click the Browse button next to the Reference data text
box.

8. In the Choose Reference Data dialog box, navigate to
the Atlanta personal geodatabase. Double-click the
personal geodatabase, click the altname table, then click
Add.

9. In the Alternate Name table tab, click the Join ID
dropdown list, then click ALTNAME_ID.

The ALTNAME_ID column in the altname table and
the OBJECTID column in the streets feature class are
used to join the table and the feature class together.

10. On the right under Matching Options, click Place Name
Alias Table.

The Alias Table dialog box appears.

11. Click the Browse button, then navigate to the Atlanta
geodatabase. Double-click the personal geodatabase,
click the place_aliases table in the Atlanta geodatabase,
then click Add.

12. Click the Alias field dropdown arrow, then click NAME.

13. Click OK.

Q
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14. Click OK in the New US Streets with AltName (GDB)
Geocoding Service dialog box. The new
yourLogin.Atlanta_AltName geocoding service appears
in the Geocoding Services folder.

15. Click the File menu and click Exit to close ArcCatalog.

Now you can use this geocoding service to find out where
an address is located on a map.

Finding locations using alternate names and place
name aliases

1. Open a new map document in ArcMap. Don�t save the
map you created in the previous task.

2. Add the streets feature class from the Atlanta
geodatabase to your map.

3. Click the Find button on the Tools toolbar.

4. In the Find dialog box, click the Addresses tab.

5. Click the Browse button to choose a geocoding service.
Navigate to the Geocoding Services folder, click the
yourLogin.Atlanta_AltName geocoding service, and
click Add.

A street may have more than one name. For example,
�Atlanta Blvd� is defined as an alternate name for �Old
10th St NE�. With the yourLogin.Atlanta_AltName
geocoding service, �30 Old 10th St NE� and �30 Atlanta
Blvd� will both find the same location.

6. Type �30 Old 10th St NE� in the Street or Intersection
text box, then click Find.

7. Right-click the candidate and click Add as Graphic(s) to
Map.

A graphic point representing the address�s location
appears on the map.

8. Type �30 Atlanta Blvd� in the Street or Intersection text
box, then click Find.

9. Right-click the candidate and click Flash Candidate
Location(s). You can see that both addresses are
matched to the same location on the map.

In addition to geocoding addresses, you can also
geocode place names that have been defined in the
place_aliases table.
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10. Type �Children�s Hospital� in the Street or Intersection
text box, then click Find.

11. Right-click the first candidate in the candidates list,
which has a score of 100, and click Add as Graphic(s)
to Map.

The location of the hospital appears on the map as if
you had typed its complete address.

12. Click Cancel to close the Find dialog box.

Creating geocoding services that use alternate names and
place name aliases is beneficial for people who know a
landmark�s name but not its address. It will also help in
situations where a street has more than one name.
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With ArcInfo� and ArcEditor� your geocoding results
can be dynamically linked to the original addresses if the
address table and the result feature class are stored in the
same geodatabase. With dynamic results, modifications to
the primary address table will cause the result feature class
to be updated automatically. ArcView® users will not be
able to complete this exercise.

1. Open a new map document in ArcMap.

2. Add the customers table in the Atlanta geodatabase to
your map.

3. Click the Tools menu, point to Geocoding, then click
Geocode Addresses. Or right-click the customers table
in the Source tab of the map�s table of contents and
click Geocode Addresses.

4. Click Add in the Choose a geocoding service to use
dialog box.

5. In the Add Geocoding Service dialog box, navigate to
the Geocoding Services folder, click the
yourLogin.Atlanta geocoding service, then click Add.

6. Click yourLogin.Atlanta in the Choose a geocoding
service to use dialog box, then click OK.

7. In the Geocode Addresses: yourLogin.Atlanta dialog
box, click the Browse button to define the Output
shapefile or feature class.

8. In the Saving Data dialog box, navigate to the Atlanta
personal geodatabase, then double-click the personal
geodatabase. Click the Save as type dropdown arrow,
then click Personal Geodatabase feature classes. In the
Name text box, type �dynamic_results�. Click Save.

Exercise 3: Creating a dynamic feature class
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9. Click Create dynamic feature class related to table.

A new point feature class named dynamic_results will
be created in the Atlanta geodatabase. The point
features generated by the geocoding process will be
saved in that feature class. A relationship between the
table and feature class will be created.

10. Click OK to start geocoding.

When the geocoding process is finished, the Review/
Rematch Addresses dialog box appears.

11. Click Done.

A Geocoding Result layer is added to the map. It shows
the points that were added to the dynamic_results
feature class.

12. Right-click the Geocoding Result layer in the map�s
table of contents and click Open Attribute Table.

The first record in the table has the address
1171 PIEDMONT AVE NE in the Street or Intersection
column. The Status, Score, and Side columns contain the
values M, 100, and R, respectively. To see on the map
where this customer is located, select this record in the
table.

13. Minimize the Geocoding Result layer�s attribute table.

14. Right-click the customers table in the map�s table of
contents and click Open.

The address that appears for the first customer in the
table, Ace Market, is 1171 Piedmont Ave NE. That
customer has moved to a new address, 30 12th St. Its
ZIP Code remains the same. The customers table must
be updated with this information.

15. Click the Editor Toolbar button to show the Editor
toolbar.

Editor Toolbar

7
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16. On the Editor toolbar, click the Editor menu and click
Start Editing.

17. Type �30 12TH ST� in the Address column next to Ace
Market.

18. Click another record in the table.

19. Minimize the customers table and maximize the
Geocoding Result layer�s attribute table.

The new address was geocoded automatically, and the
corresponding values have been updated in the layer�s
attribute table. The Status, Score, and Side columns now
contain the values T, 81, and L, respectively. The value
�T� in the Status field stands for tied; two or more
candidates had the highest score. To see on the map
where Ace Market is now located, select this record in
the layer�s attribute table.

Now you need to add a new customer to the customers
table.

20. Minimize the Geocoding Result layer�s attribute table
and maximize the customers table.

21. Scroll down to the bottom of the customers table.

22. In the blank record after the last record in the table,
click in the NAME column. Type �Vine Cafe�.

A new blank record is added to the bottom of the table.

23. In the same record, click in the ADDRESS column, then
type �379 VINE ST NW�.

24. Click in the ZIP column, then type �30314�.

25. Click in the TYPE column, then type �Cafe�.

26. Click in the SALES column, then type �10000�.

27. Close the customers table. Maximize the Geocoding
Result layer�s attribute table, then scroll to the bottom.

A new feature was automatically added to the result
feature class representing the new address.

28. On the Editor toolbar, click the Editor menu and click
Stop Editing. Click Yes to save your changes.

29. Click the File menu and click Exit. Click No to stop
ArcMap without saving this map.
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If ArcInfo or ArcEditor is installed on your computer, and if you
have access to an ArcSDE� geodatabase, you can do server-
side geocoding. Instead of creating geocoding services on your
computer, you create and store them on the server. Server-side
geocoding services are easily shared by many users in an
organization. When you use them, the server will do the work of
matching addresses to geographic locations.

Once you have created a database connection that accesses the
appropriate ArcSDE server, you can copy the streets feature class
and the altname, customers, and place_aliases tables from the
Atlanta personal geodatabase to the ArcSDE geodatabase. This
tutorial could be completed by using data in the ArcSDE
geodatabase instead of the Atlanta personal geodatabase.

Geocoding addresses on an ArcSDE server

If you choose to do so, create your geocoding services in the
Geocoding Services folder within the database connection and
use the data located in the same database. The result feature
classes created by the geocoding process can also be stored
within the ArcSDE geodatabase. Aside from these differences, the
geocoding process will be the same as what you experience when
you use client-side data and geocoding services to complete this
tutorial.
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